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AKVIS OILPAINT 11.0 | OIL PAINTING EFFECT FOR YOUR PHOTOS

AKVIS OilPaint is photo to painting software that creates oil paintings from photographs. The characteristic feature of the program
is a unique algorithm of the artistic application of brush strokes that authentically reproduces the technique of the real brush.

Oil Painting is one of the most popular painting techniques. The history of this method goes back many centuries. Traditionally,
artists apply oil paints to a linen or cotton canvas. The advantages of oil painting are bright luminous colors that blend well,
expressiveness of the brush strokes that give the picture a special rough texture, brilliance, and naturalness of a picturesque
image.

The oil painting technique is widely used for creating artworks in different artistic styles - Impressionism, Abstract art,
Photorealism, and others; in the genres of still life, landscape, portraiture, history painting, or scenes from everyday life.

Creating an oil painting is a long and complicated process. With AKVIS OilPaint you can become a painter and turn your photos
into works of art in just a few minutes!
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Even if you are not a professional painter you can create your masterpiece! Just use AKVIS OilPaint to transform a regular photo
into an oil painting. Adjusting the density, texture, and thickness of the brush strokes, you can not only get impressive effects but
also find your own painting style.

The mysterious production of an artwork happens right before your eyes. The program creates a picture that looks like a handmade
oil painting.
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In AKVIS OilPaint, you can adjust the effect parameters for generating brush strokes and change the overall look and style of an
oil painting. The photo-to-painting conversion settings are divided between the Image, Strokes, and Edge tabs. Generate your
artwork in a click! You can enhance the hand-painted look by adding artistic messy strokes to the painting's edges.

The incredible Timeline feature makes snapshots during photo to painting processing and lets you choose between them.

Experiment with the effect and create digital art!

Applying the additional Abstract Art effect, you can give a modern spin to traditional oil paintings. It lets you turn any image into a
unique abstract painting full of vibrant colors and fantastical shapes.

Get creative with AKVIS OilPaint!
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AKVIS OilPaint offers a set of ready-to-use Presets that store combinations of settings and allow you to quickly select different
options of the oil effect. The Batch Processing support allows you automatically create a series of images in the oil painting style.

Using the additional Post-Processing Tools (History Brush, Smudge tool, Oil Brush, and 3D Brush), you can add final touches
to your painting, and strengthen or reduce the oil effect on certain areas.
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Make your masterpiece even more impressive using the Decoration features (Canvas/Text/Frame).

Adjust the canvas surface in the Canvas tab for a more natural look. Personalize your work by adding an inscription, logo, or
watermark using the Text feature. Put your artwork in one of the gorgeous frames from the rich collection in the Frame tab.

AKVIS OilPaint is available as a standalone program and as a plugin to photo editors: AliveColors, Adobe Photoshop, Photoshop
Elements, Corel PaintShop Pro, etc. Consult the compatibility page for more details.

The functionality of the program depends on the license type. During the trial period, you can try all options and choose the license
you like.
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INSTALLATION ON WINDOWS

Please find instructions below on how to install the AKVIS programs on Windows.

You must have administrator rights to install the program on your computer.

Before installing the AKVIS plugins, please make sure that the image editor where you want to install the plugins, is closed. Or re-
run the image editor after the installation of the plugin.

 

1. Run the setup exe file.
2. Select your language and press the Install button.
3. To continue the installation process you have to read and accept the End User License Agreement.

Activate the check box "I accept the terms in the License Agreement", and press Next.

4. To install the Plugin, select your photo editor(s) from the list.

To install the Standalone version, make sure that the corresponding option is activated. 
To create a shortcut for the program on desktop, activate Desktop Shortcut.

Press Next.

5. Press the Install button.
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6. The installation is in progress.

7. The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates, events, and special offers. Enter your e-mail
address and confirm that you accept the Privacy Policy.
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8. Press Finish.

After installation of the standalone version, you will see the program name in the Start menu and a shortcut on the desktop, if
during installation the corresponding option was enabled.

After installation of the plugin, you will see a new item in the Filter/Effects menu of your photo editor. For example in Photoshop:
Filter -> AKVIS –> OilPaint, in AliveColors: Effects -> AKVIS –> OilPaint.
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INSTALLATION ON MAC

Follow the instructions to install the AKVIS software on a Mac computer.

You must have administrator rights to install the program on your computer.

 

1. Open the dmg file:

- akvis-oilpaint-app.dmg to install the Standalone version

- akvis-oilpaint-plugin.dmg to install the Plugin into your image editor.

2. Read the License Agreement and press Agree, if you agree with the conditions.

3. Finder will open with AKVIS OilPaint application or AKVIS OilPaint PlugIn inside.

 

4. To install the Standalone version, drag the AKVIS OilPaint app into the folder Applications (or any other place you like).

To install the Plugin, drag the entire AKVIS OilPaint PlugIn folder into the Plug-Ins folder of your graphic editor:

AliveColors: You can choose in the program's Preferences the folder of the plugins.

Adobe Photoshop: Library/Application Support/Adobe/Plug-Ins/CC 
(except CS6 version: Applications/Adobe Photoshop CS6/Plug-ins)
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After installation of the plugin, you will see a new item in the filters/effects menu of your photo editor. 
Select in Photoshop: Filter -> AKVIS -> OilPaint, in AliveColors: Effects -> AKVIS -> OilPaint.

Run the standalone application by double-clicking on its icon in Finder.

You can also run the AKVIS programs from the Photos app by choosing the Image -> Edit With command (in High Sierra and later
versions of macOS).
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INSTALLATION ON LINUX

Note: The AKVIS programs are compatible with Linux kernel 5.0+ 64-bit. You can find out the kernel version using the
uname -srm command.

 

Follow the instructions to install the AKVIS software on a Linux computer.

 

Installation on Debian-based systems:

Note: You need apt-install or apt-get permissions required to install software.

1. Run the terminal.
2. Create a directory to store keys:

sudo mkdir -p /usr/share/keyrings 

3. Download the key that signed the repository:

curl -fsSL https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 

or

wget -O - https://akvis.com/akvis.gpg | sudo tee /usr/share/keyrings/akvis.gpg >/dev/null 

4. Add the repository to the list where the system looks for packages to install:

echo 'deb [arch-=i386 signed-by=/usr/share/keyrings/akvis.gpg] https://akvis-deb.sfo2.cdn.digitaloceanspaces.com akvis
non-free' | sudo tee /etc/apt/sources.list.d/akvis.list 

5. Update the list of known packages:

sudo apt-get update 

6. Install AKVIS OilPaint

sudo apt-get install akvis-oilpaint 

7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates, use the command:

sudo apt-get upgrade 

To remove the program:

sudo apt-get remove akvis-oilpaint --autoremove 

 

Installation on RPM-based systems (CentOS, RHEL, Fedora):

1. Run the terminal.
2. Register the key that signed the repository:

sudo rpm --import https://akvis.com/akvis.asc 

3. Add the repository to the system:

sudo wget -O /etc/yum.repos.d/akvis.repo https://akvis.com/akvis.repo 

4. Update the package list:

when using the dnf package manager:

sudo dnf update 

when using the yum package manager:

sudo yum update 

5. Install AKVIS OilPaint:

when using the dnf package manager:

sudo dnf install akvis-oilpaint 
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when using the yum package manager:

sudo yum install akvis-oilpaint 

6. The installation is completed.

Launch the program via the terminal or using the program shortcut.

7. For automatic updates:

when using the dnf package manager:

sudo dnf upgrade 

when using the yum package manager:

sudo yum upgrade 

8. To remove the program:

when using the dnf package manager:

sudo dnf remove akvis-oilpaint 

when using the yum package manager:

sudo yum remove akvis-oilpaint 

 

Installation on openSUSE.

1. Run the terminal.
2. Login as a root user.
3. Add the key that signed the repository:

rpm --import http://akvis.com/akvis.asc 

4. Add the repository to the system:

zypper ar -r https://akvis.com/akvis.repo akvis 

5. Update the package list:

zypper ref 

6. Install AKVIS OilPaint:

zypper install akvis-oilpaint 

7. The installation is completed.

Launch the program via the terminal or using the program shortcut.

8. For automatic updates:

zypper update 

To remove the program:

zypper remove akvis-oilpaint 

 

Installation using Flatpak:

1. Run the terminal.
2. Add the Flathub repository

sudo flatpak remote-add --if-not-exists flathub https://flathub.org/repo/flathub.flatpakrepo 

3. Add the AKVIS repository

sudo flatpak remote-add --if-not-exists akvis --from https://akvis-
flatpak.sfo3.cdn.digitaloceanspaces.com/com.akvis.flatpakrepo 

4. Install AKVIS OilPaint:
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sudo flatpak install -y akvis com.akvis.akvis-oilpaint 

5. The installation is completed.

Launch the program using the program shortcut or the terminal:

flatpak run com.akvis.akvis-oilpaint 

6. To update all installed flatpaks, use the command:

sudo flatpak update -y 

to remove the program:

sudo flatpak remove -y com.akvis.akvis-oilpaint 

 

In order to display the program interface correctly, it is recommended to install the Compton or Picom composite manager.
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AKVIS SOFTWARE ACTIVATION

Attention! During the activation process your computer must be connected to Internet.

If it is not possible, we offer you an alternative way (see below for Offline Activation).

 

Download AKVIS OilPaint and install the program. Read the Installation Instruction here.

When you run the unregistered version, a splash window will appear displaying general information about the version and the
number of days left in your trial period.

You can also open the About the Program window by pressing the button  in the program's Control Panel.

 

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.

You do not need to register the trial version to try all features of the software. Just use the program during the evaluation time (10
days after the 1st start).

During the test period you can try all options and choose the license you like. Select one of the offered functionality types: Home
(Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available in the
program. Consult the comparison table for more details about license types and versions of the software.

If the trial period has expired, the TRY IT button is disabled.

 

Click on BUY NOW to choose a license to order.

When the payment is effected, your serial number for the program will be sent to you within minutes.

 

Click on ACTIVATE to start the activation process.
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Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

Direct connection:

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press ACTIVATE.

Your registration is completed!

Request by e-mail:

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

NOTE: You can also use this method for Offline Activation:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet, for
example, with a USB stick. Send us this information to: activate@akvis.com.

Please do not send the screenshot! Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (OilPaint.lic) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the AKVIS folder in Users’
Shared (Public) Documents:

Windows:

C:\Users\Public\Documents\AKVIS

(This PC > Local Disk (C:) > Users > Public > Documents > AKVIS)

Mac:

/Users/Shared/AKVIS

Open the Finder, select the Go menu, then select Go to Folder... (⌘ +Shift+G ), type "/Users/Shared/AKVIS",

and click Go.

Linux:

/var/lib/AKVIS

Your registration is completed!
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18

mailto:activate@akvis.com


 

When the program is registered, BUY NOW turns to UPGRADE that lets you improve your license (for example, change Home to
Home Deluxe or Business).
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WORKSPACE

AKVIS OilPaint can work independently as a standalone program as well as a plugin to a photo editor.

Standalone is an independent program. You can run it in the usual way.

Plugin is an add-on for graphics editors, for example for Photoshop, AliveColors, and other compatible programs. To call the
plugin, select it from filters of your image editing program.

The workspace will be arranged according to the interface mode chosen in the Control Panel: Express, Advanced, or Presets.

The first time you run the program, it is displayed in Express mode, with a simplified interface and a minimal set of sliders, which
help to quickly obtain a satisfactory result.

AKVIS OilPaint Workspace, Express Mode

Experienced users who are familiar with the capabilities of AKVIS OilPaint can switch to Advanced mode: the interface's
appearance will change, granting access to the full functionality of the program.

Note: All features and parameters work in Express mode as well; some are hidden and the program uses values of a chosen
preset.
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AKVIS OilPaint Workspace, Advanced Mode

The Presets button in the top panel allows you to switch to the visual display mode of presets (Presets Gallery).

AKVIS OilPaint Workspace, Presets Mode

 

The left part of the AKVIS OilPaint window is taken by the Image Window with two tabs: Before and After. Under the Before
tab you can see the original photo. The After tab shows the resulting image. You can switch between the windows by clicking the
tab. To compare the original and the resulting images, click in the image and hold the button pressed - the program will currently
switch between tabs.

In the upper part of the program's window, there is the Control Panel with the following controls:

The button  opens the home page of AKVIS OilPaint.
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The button  (only in the standalone version) opens an image for processing. The hot-keys are Ctrl+O  on Windows,

⌘ +O  on Mac. 

Right-click this button to display the list of recent files. You can change the number of recent documents in the
Preferences.

The button  (only in the standalone version) saves the image to the disk. The hot-keys are Ctrl+S  on Windows, ⌘ +S

on Mac.

The button  (only in the standalone version) calls the Print dialog box. The hot-keys are Ctrl+P  on Windows, ⌘ +P  on

Mac.

The button  loads a list of presets (.oilpaint file).

The button  saves user presets to a file with the .oilpaint extension.

The button  (only in the standalone version) opens the Batch Processing dialog to automatically process a series of

images.

The button  loads saved guiding lines (.direction file).

The button  saves the guiding lines to a .direction file.

The button  /  shows/hides the guiding lines.

The button  cancels the last operation (with the tools). It is possible to cancel several operations in a row. The hotkeys

are Ctrl+Z  on Windows, ⌘ +Z  on Mac.

The button  returns the last canceled operation. It is possible to return several operations in a row. The hotkeys are

Ctrl+Y  on Windows, ⌘ +Y  on Mac.

The button  initiates image processing with the current settings. The resulting image is shown in the After tab.

The button  (only in the plugin version) applies the result to the image and closes the plugin.

The button  shows information about the program: version, trial period, license.

The button  calls the Help files. The hot-key is F1 .

The button  calls the Preferences dialog box for changing the program's options.

The button  opens a window showing the latest news about OilPaint.

To the left of the Image Window, there is the Toolbar. Different tools appear on the Before/After tabs.

Navigate and scale the image using the Navigator. The frame in the Navigator surrounds the area of the image which is visible in
the Image Window; the area outside of the frame will be shaded. The frame can be dragged, thereby changing the visible portion
of the image. To move the frame, place the cursor within it, left-click the mouse, and drag.

Navigator

To scroll the image in the Image Window you can press the spacebar on the keyboard and drag the image with the left mouse
button. Use the scroll wheel of the mouse to move the image up/down, by keeping the Ctrl  key pressed – to the left/to the right,
by keeping the Alt  key pressed − scale the image. Right-click the scroll bar to activate the quick navigation menu.

Use the slider to scale the image in the Image Window. When you move the slider to the right, the image scale increases. When
you move the slider to the left, the image scale reduces.

You can also change the image scale by entering a new coefficient into the scale field. The fall-down menu shows some frequently
used coefficients.

You can use hot-keys to change the image scale +  and Ctrl++  (⌘ ++  in Mac) to increase the image scale and -  and Ctrl+-

(⌘ +-  in Mac) to reduce the scale.

 

Under the Navigator, there is the Settings Panel with the Presets list and the tabs of parameters:

Painting: Here you can adjust the parameters for photo-to-painting conversion.
Abstract Art: Create colorful artworks with whimsical and fantastic shapes.
Decoration: You can add text to your image, adjust the canvas, and apply a frame.
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Under the settings, you can see Hints for the parameters and buttons when you hover over them with the cursor. You can choose
where the hints will be shown or hide them in the program's Preferences.
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HOW TO USE THE PROGRAM

AKVIS OilPaint is photo to painting software that creates oil paintings from photographs. It can work independently as a
standalone program and as a plugin to a photo editor.

Follow the instructions below:

Step 1. Open an image.

- If you work with the standalone edition:

The dialog box Select File to Open appears if you double-click on the empty workspace of the program or if you press

on . Use the hot-keys: Ctrl+O  on Windows, ⌘ +O  on Mac. You can also drag the required image into the

workspace of the program.
The standalone program supports JPEG, RAW, PNG, BMP, WEBP, and TIFF file formats.

- If you work with the plugin:

Open an image in your photo editor by calling the command File -> Open.

Call the plugin from the menu of the editor:

In AliveColors: Effects -> AKVIS -> OilPaint;
in Adobe Photoshop: Filter -> AKVIS -> OilPaint;
in Corel PaintShop Pro: Effects -> Plugins -> AKVIS -> OilPaint;
in Corel Photo-Paint: Effects -> AKVIS -> OilPaint.

The workspace will be arranged according to the interface mode chosen in the Control Panel: Express, Advanced, or
Presets.

AKVIS OilPaint Window

Step 2. Before applying the effect, in the standalone version, you can use the Crop tool  to trim a part of the picture. If

using the plugin, you can do this in your image editor.
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Crop Tool

Step 3. Adjust the oil painting settings in the Painting tab.

Using the Abstract Art tab you can change the shape and color of objects, giving them a unique and fantastic look.

You can use one of the ready-to-use Presets or set the parameters to your liking.

The result of image processing will be immediately shown in the preview area which is visible in the Before tab if the button 

 in the Toolbar is pressed.

Preview Window

Step 4. Press the Run button  to convert the entire image into an oil painting with the selected settings. To interrupt the

process, click the Stop button right to the progress bar.

Hint: By default, Animated Processing is enabled, and you can observe the photo-to-painting conversion in real-time. You
can disable the option in the Preferences to improve image processing speed.
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Oil Painting Effect

Step 5. For the advanced licenses (Home Deluxe/Business), it is possible to improve the result using the Stroke Direction

tool . It changes the direction of the brush strokes created during the automatic conversion.

Step 6. To make your oil painting even more impressive, you can use the Decoration options: adjust the canvas, apply a
frame, and add text to your image.

Hint: Drag the Canvas/Frame/Text tabs to change the order of application of these effects.

Oil Painting on Canvas with Signature

Step 7. It is possible to save the settings you like as a Preset and use them in the future.

Click /  near the preset name field to add the preset to Favorites or to remove it from this group of presets.

Learn more about the OilPaint Presets.

Step 8. The Timeline feature allows you get variations of your drawing without adjusting the settings. If you like some semi-
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processed image more than your final result, click on it to choose. The shot will be shown in the After tab.

If you want to get back to your final result, click on the last shot in the Timeline list.

Note: This feature is only available for the Home Deluxe and Business licenses.

Timeline Shots

You can set the number of the shots in the Preferences dialog box.

Step 9. You can also make final touches and correct the result using the Post-Processing Tools , , ,  in the

After tab. These brushes are only available under the Home Deluxe/Business licenses.

Attention! Use the post-processing tools at the final step. If you re-run the image processing , the changes made with

the tools, will be lost!

Step 10. In the standalone version you can also print your oil painting with .

Step 11. Save the processed image.

- If you work with the standalone edition:

Click  to open the Save As dialog box. You can use the hot-keys: Ctrl+S  on Windows, ⌘ +S  on Mac. Enter a

name for the file, choose the format (TIFF, BMP, JPEG, WEBP or PNG) and indicate the target folder.

- If you work with the plugin:

Press the button  to apply the result and close the plugin window. The AKVIS OilPaint plugin will close and the

picture will appear in the workspace of the photo editor.

Call the Save As dialog box using the command File -> Save As, enter a name for the file, choose the format, and
indicate the target folder.

Result
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TIMELINE

AKVIS OilPaint lets you observe the conversion of your photo into an oil painting in real time. During the process, the program
creates a list of intermediate shots which represent different stages of conversion — from a semi-processed painting to practically
finished work. Without changing the settings you can create variations of paintings! You can also quickly compare the results
achieved in different styles.

To display the Timeline at the bottom of the main window, enable the option in the Preferences.

AKVIS OilPaint

Note: Selecting a frame in the Timeline is only available in the Home Deluxe and Business versions. Note that everyone, even with a
Home license, can get a semi-processed image using the Stop button in the progress bar.

 

Start conversion of your photo into an oil painting by pressing the button . You will see shots appearing at the bottom of the

window in the course of processing.

You can also take snapshots of your favorite moments with the button  right of the progress bar. When you press it, the

painting in its current state will be added to the list; such manual shots are selected with the blue frame.
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Image Processing

If you press the Stop button in the progress bar, image processing will be interrupted.

Browse the shots in the Timeline to find the image you like most. If you want to get back to your final result, click on the last shot
in the list.

Variants of Painting

When you change the parameters and re-run image processing, the Timeline will be cleaned up and will start being filled up with
new shots. You can save some of the variants by pinning them with a double click. In the upper corner of the selected shot

appears the icon .

You can switch between the shots, change the settings and re-start processing - the pinned result will remain in the list. It's
possible to unpin it with a double click.

To delete a snapshot, select it in the Timeline and click on .

Attention! Pinned shots can't be removed with this button! 
Loading a new image into the program removes all shots, including pinned ones.

 

The selected result will be shown in the Image Window under the After tab.

You can modify it with the post-processing tools.
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Attention! After using the post-processing tools, switching to another image in the Timeline will result in the loss of changes
made with the tools. You can save the result under a new name and continue working.

 

You can hide/show the Timeline in the program's preferences . If the Timeline Shots option is enabled, you can set the

number of the shots created during image processing.

Program's Preferences
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TOOLS AND THEIR OPTIONS

The left panel in AKVIS OilPaint (Toolbar) contains three groups of tools: pre-processing, post-processing, and additional tools.
Different tools are visible depending on the active tab - Before or After.

Toolbar
Before tab

Toolbar
After tab

Hint: Use the buttons  and  in the Control Panel or the hot-keys Ctrl+Z /Ctrl+Y  to undo/redo the operations made

with the tools: , , , , , .

 

Pre-Processing Tools (on the Before tab):

Quick Preview  switches on/off the preview window. It is a square frame outlined with the "marching ants" that displays

changes made in the Painting and Decoration tabs.

You can drag the preview square to any position with the left mouse button or with the double click. This lets you quickly
preview the effect in different areas of the image. To compare the result of automatic conversion with the original picture,
click and keep mouse pressed within the preview area.

Preview Window

You can adjust the preview window size in the program's Preferences .

 

Crop  (in the standalone version) lets you cut off unwanted areas in the image. The tool is useful when you want to

improve the image composition, straighten a crooked photo, turn a horizontal photo into a vertical one and contrariwise.

Note: This tool is applied to the original image! Use it before the oil effect.

You can change the crop area by dragging the sides and the angles of the bounding frame.

Use the buttons in the Settings Panel to control the tool:

To apply the result and remove the areas outside the frame, press OK or use Enter . To cancel the operation and exit the

tool, press Cancel or use the Esc -key. To restore the original area keeping the tool active, press Reset button.
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Automatic Brush Strokes Guiding Lines Changing Direction

Crop Image

Adjust the crop parameters:

You can choose the size of the crop rectangle using the Ratio or Fixed Size options.

If the External Area check-box is enabled, you can change the color and opacity of the outer parts.

 

Stroke Direction tool  gives you full control over the strokes. With this technique you can achieve truly realistic paintings

with human hair, patterns, and textures going in the right direction.

Note: This feature is only available for advanced licenses (Home Deluxe, Business).

Add the guiding lines with this tool, and the program will re-make the painting following the new direction. The changes will be

shown in the preview window. To process the entire image, click .

 

Hint: You can save  and load  the guiding lines created with this tool. The lines loaded into the program

automatically adapt to the image size.

 

Eraser  lets you edit and remove the guiding lines drawn with the Stroke Direction tool . The size of the eraser can

be adjusted by right-clicking on the image.
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Oil Painting Effect Using Smudge

Post-Processing Tools (on the After tab, for Deluxe/Business):

Attention! The tools , , ,  are only available under the Home Deluxe/Business licenses, on the After tab. Use them

at the final step. If you re-run the image processing , the changes made with the post-processing tools will be lost!

Watch the video tutorial that demonstrates how to use the post-processing tools.

The options of these tools are shown in a pop-up box which appears after right-clicking on the image.

Smudge  is used to manually refine the image by removing paint irregularities. It mixes colors by displacing pixels, like a

finger passing through wet paint. The tool lets you quickly add a handmade touch to your oil painting.

The tool's parameters:

Size (1-300). The maximum width of a line drawn with the tool.

Hardness (0-100). The amount of blurriness of the outer edge. The higher the value, the harder the brush edge is.

Strength (1-100). The intensity of smearing the paint in the brush stroke. The higher the value, the more color is
smeared.

 

History Brush  lets you fade the effect and restore the image to its original state. You can choose the mode of the tool:

edit all changes or only brushes keeping the oil effect.

The tool's parameters:

Restore to Original. If the check-box is enabled, the tool lets you weaken the oil painting effect, as well as the result
of the post-processing brushes. If the check-box is disabled, the tool edits only these brushes but does not affect the
oil effect.

Size (1-500). The maximum width of a line made by the brush.

Hardness (0-100). The blurriness of the tool's edges. The less the value the more blurry the tool's edges become. At
value 100% the border between the brush's edges and the background is very distinct; at lower values the transition
between these areas is smoother.

Strength (1-100). The degree of restoration to the original state. At lower values there will be less restoration and
more blending with the effect; at value 100% the original image will be restored more completely.
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Oil Effect Using History Brush

Relief = 10 Relief = 100

Paint Reserve = 10 Paint Reserve = 50

 

Oil Brush  is designed to strengthen the oil effect on desired areas. This tool lets you make high-quality strokes that look

like made with a real oil paint brush.

Size (2-150). The maximum line width which can be drawn with the brush.

Relief (0-100). The prominence of stroke details. As this parameter is increased, the pattern left by the brush's hairs in
the paint is more pronounced and the relief of strokes is stronger.

Paint Reserve (0-100). The length of the brush stroke. When the paint runs out, the brush stops painting on the
surface and leaves a raised, faded stroke of paint.

Color Mixing. This option defines the state of the paint in a stroke. When the check-box is enabled, the brush strokes
will mix together as if the paint is wet. If the check-box is disabled, the paint will behave as if it is drying, and the
strokes will not mix.

Color Mixing is disabled Color Mixing is enabled

Cleaning. This option works only if Color Mixing is active. If the check-box is enabled, the brush will clean for each
new stroke, a new line will start with the defined color. When it is disabled, a new stroke will be drawn with the color
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Cleaning is disabled Cleaning is enabled

Flat Brush is enabled Flat Brush is disabled

that brush had at the end of the previous stroke.

Flat Brush. The check-box changes the shape of the edges of the brush strokes. If it is enabled, the strokes look like
drawn with a flat brush or a palette knife. When this option is disabled, the brush strokes look like created with a round
brush or as if paint squeezed out of a tube.

Color. The color square on the Toolbar under the Oil Brush displays the selected color for this tool. There are two ways to
change colors for the brush:

Double-click within the plate and choose a color from the Select Color dialog.

Left-click on the square (or use the I -key) to activate the Eyedropper tool, then pick a color from the image.

Eyedropper

Around the eyedropper's tip over the image there is a color ring that helps you select colors more precisely. If it's hard to
catch a certain color, you can see adjacent tints and select the color on the ring while holding the Ctrl -key.

There are 5 sectors on the color ring:

1. Gradient line with the current color in the center. 
On the left side is +30% black, and on the right side +30% white.

2. The previously selected color.
3. The current color of the pixel where the cursor is.
4. Colors of surrounding pixels.
5. Average colors from areas of 3x3, 5x5, 11x11, 31x31, 51x51, 101x101 px.
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Smearing = 0 Smearing = 90

Relief = 10 Relief = 50

3D Brush  lets you bring volume and relief to your painting. The tool draws prominent strokes without changing colors.

Size (2-300). The maximum width of a line drawn with the tool.

Smearing (0-100). The parameter defines the state of the paint when drawing with the brush. At value = 0 the
strokes do not mix together. The higher the value, the more strokes will be smeared and mix.

Relief (0-100). The prominence of the traces of the brush strokes. The higher the value, the more expressive the
strokes are. At low values it gives the smoothing effect.

Flat Brush. It works similarly to the same option of the Oil Brush.

 

Additional Tools (available on both tabs, for all licenses):

Hand  lets you scroll the image when it does not fit within Image Window at the desired scale. To use it, click the button,

bring the cursor over the image, and while keeping the left mouse button pressed move in the desired direction. The hot-key
is H .

Double-clicking the tool's icon  in the Toolbar makes the image fit the window.

Zoom  lets you change the image's scale. To zoom in, left-click in the image. To zoom out, left-click with Alt  in the

image. The hot-key is Z .

Double-clicking the tool's icon  makes the image scale to 100% (actual size).
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Blend with Original = 0

 
Blend with Original = 50

OIL PAINTING EFFECT

AKVIS OilPaint creates oil paintings from photos. The unique algorithm authentically reproduces the technique of an artist's brush.
The mysterious transformation happens right before your eyes, creating a piece of art that looks like a handmade painting.

Oil Painting from Photo

 

In the Express workspace mode, you see only six parameters in the Settings Panel. Switch to the Advanced mode to open all
tabs of the parameters and all tools.

Adjust the effect parameters in the Painting tab. You can change the photo-to-painting conversion settings in the Image and
Strokes tabs and apply the additional edge processing in the Edge tab.

 

Blend with Original (0-100). The effect can be merged with the original image by changing the transparency of the result. With a
value of 0, no blending occurs. The higher the parameter, the more the original colors are mixed with the result.
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Normal

 
Linear Burn

Simplicity = 2 Simplicity = 10

Direction = 5 Direction = 80

In the Mode drop-down list, you can set the blending method.

The Image tab defines the overall look and style of an oil painting.

Simplicity (1-15). It adjusts the simplification of the image. The higher the value, the more details disappear, and the image
becomes more like a painting and less like a photo.

Direction (0-100). It changes the mutual orientation of the brush strokes. With lower values, the strokes are located along
the edges; with higher values, the strokes follow a common direction.

Wide Background Strokes (1-10). It scales the size of the brush strokes in uniform areas. This effect creates more realistic
results on backgrounds and close-up portraits.
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Wide Background Strokes = 1 Wide Background Strokes = 10

Expression = 10 Expression = 50

Filling = 0 Filling = 100

Expression (5-100). It generates painterly broad strokes with uneven edges and mixing paint, and intensifies the
picturesque appearance and artistic impression.

Filling (0-100). It completes the painting in empty spaces.

Relief (0-100). It creates the effect of volumetric brush strokes protruding above the surface of the canvas.
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Relief = 5 Relief = 20

Lightening = 0 Lightening = 50

Stroke Thickness = 5 Stroke Thickness = 60

Lightening (0-100). It adds white areas making the image lighter.

Random Seed (0-9999). It randomizes the arrangement of the brush strokes.

 

In the Strokes tab, you can change the parameters of a brush stroke.

Stroke Thickness (1-100). It adjusts the width of the brush strokes.

Max Stroke Length (1-100). It defines the maximum stroke length.
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Max Stroke Length = 1 Max Stroke Length = 70

Min Stroke Length = 1 Min Stroke Length = 100

Hair Thickness = 10 Hair Thickness = 50

Min Stroke Length (1-100). It changes the minimum stroke length (in % of the value of the maximum stroke length).

Hair Thickness (10-100). It defines the width of the bristles in the brush. At lower values, the brush hairs are sharp and
thin; at high values, they are wide and smooth.

Brush Density (1-100). It sets the number of the bristles in the brush.

AKVIS OilPaint

41



Brush Density = 1 Brush Density = 50

Intensity = 5 Intensity = 100

Intensity (1-100). It changes the sharpness and contrast of the strokes. At low values of the parameter, the strokes are
mixed.

 

In the Edge tab, you can set the parameters of the additional edge processing of the oil painting. With this effect, you can imitate
raw canvas edges or frame the image with an original border of colored strokes.

Note: This additional edge processing is only available for Home Deluxe and Business licenses.

 

Add Strokes. Enable the check-box to draw additional strokes along the edges of the image.
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Number of Strokes = 10 Number of Strokes = 60

Adding Framing Strokes

Number of Strokes (1-100). It determines the number of the brush strokes along the edges.

Stroke Thickness (0-100). It adjusts the width of the brush strokes.
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Stroke Thickness = 5 Stroke Thickness = 80

Max Stroke Length = 10 Max Stroke Length = 55

Edge Smoothness = 10 Edge Smoothness = 90

Max Stroke Length (10-100). It defines the maximum stroke length.

Edge Smoothness (5-100). It adjusts the transparency of the stroke edges.

Hair Thickness (15-50). It defines the width of the brush hairs in each stroke. At lower values, the brush hairs are sharp and thin;
at high values, they are wide and smooth.
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Hair Thickness = 15 Hair Thickness = 50

Stroke Color Disabled
(Using Background Color)

Stroke Color Enabled
(Using White Color)

Relief = 10 Relief = 90

Stroke Color. Enable the check-box to draw strokes of a specified color. Disable the check-box to use the background color.

Relief (0-100). It makes the framing strokes look more prominent.

Ellipse. Enable the check-box to arrange the strokes in the form of an oval.
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Ellipse Disabled Ellipse Enabled

Click the Random button to set the settings of the additional edge strokes randomly.

 

With the advanced licenses (Home Deluxe, Business) you can also use these tools:

In the Before tab:

The Stroke Direction tool  gives you full control over the brush strokes. With this technique, you can achieve truly

realistic paintings with human hair, patterns, and textures going in the right direction. Using this tool you can add your own
creative touch to your oil painting.

In the After tab:

You can use the post-processing tools , , ,  to manually edit the result.

Use these tools at the final step! If you re-run the processing, the changes made with these brushes will be lost!

 

AKVIS OilPaint

46

https://akvis.com/en/oilpaint/comparison.php?utm_source=help


Color = 10 Color = 90

ABSTRACT ART

Using the Abstract Art tab, you can change the shape and color of objects, giving them a unique and fantastic look.

Note: This tab is available only for Home Deluxe and Business licenses.

Abstract Art

The parameters are divided into three groups:

 

Strokes Group. The parameters change the color of strokes in the resulting image.

Color (0-90). The higher the value, the more strokes are recolored and the more colors appear in the image.

Saturation (0-40). The parameter increases the brightness of random strokes. The default value is 0.
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Saturation = 5 Saturation = 40

Contrast = 5 Contrast = 80

Hue = -35 Hue = 15

Contrast (0-100). The parameter makes random strokes darker/lighter.

 

Correction Group. The parameters change the color of the original image.

Hue (-180...180). The parameter shifts all colors by the same hue value.

Saturation (-100...100). The parameter lets toning the image with brighter colors. It allows you to change the intensity of
colors: from neutral gray tones to bright colors.
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Saturation = -100 Saturation = 20

Brightness = -80 Brightness = 80

Strength = 10 Strength = 90

Brightness (-100...100). The luminance of the image. At higher values the image is brighter while at lower values it is darker.

 

Distortion Group. The parameters change the shapes and proportions of the objects.

Strength (0-100). The amount the objects in the image are shifted and stretched. At a value of 0, there is no distortion.

Curvature (2-25). This parameter increases the waviness of contours.

AKVIS OilPaint

49



Curvature = 5 Curvature = 22

Random Seed (1-9999). This is the starting number for the random number generator that defines the deformation of shapes and
randomly combines strokes.

Random Distortions
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ADJUST A CANVAS FOR AN OIL PAINTING

AKVIS OilPaint does not only convert a photo into an oil painting, it also lets you imitate painting on a canvas or any other uneven
surface: corrugated paper, brick wall, ceramic coating, etc.

In the Decoration group, switch to the Canvas tab and enable the Use Canvas check-box.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

Oil Painting on a Canvas

You can choose a texture from Library -> Surface or load your own sample: Library -> Custom…

Adjust the canvas settings.
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APPLY FRAMES TO AN OIL PAINTING

In AKVIS OilPaint, you can also add a frame to your oil painting to create a real work of art.

In the Decoration group, switch to the Frame tab, enable the check-box of the same title, and choose the frame style and
texture.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

Oil Painting in Frame

 

You can apply these frames to your oil painting:

Classic Frame
Pattern Frame
Strokes
Vignette
Passe-Partout
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ADD TEXT OR WATERMARK TO AN OIL PAINTING

In AKVIS OilPaint, you can personalize your work of art by adding a signature, insert a logo or a watermark.

In the Decoration group, switch to the Text tab and enable one of the modes: Text or Image.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

Oil Painting with Text

Read how to adjust the text/watermark settings.
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WORKING WITH PRESETS

AKVIS OilPaint includes a number of ready to use presets (settings combinations) for the effect which help you start working.
When moving a cursor over a preset in the drop-down list, above the settings, the quick result appears in the small window near
the list.

A preset contains the settings for all tabs (Painting/Abstract Art/Decoration).

The AKVIS presets marked with * use the parameters available only for the Deluxe/Business licenses. In the Home version, these
additional effects will not be applied, such presets will use with only Painting and Decoration settings.

To create a preset, adjust the settings, type a name into the field, and press Save.

To return to the default settings of the selected preset, press Reset.

To delete a user preset, choose it from the list and press Delete.

The AKVIS built-in presets cannot be removed.

 

Next to the preset name field there is a heart icon. Click on it to add the selected preset to Favorites or to remove it from this
group of presets.

 

Presets Gallery

Click on the Presets button in the top panel to switch to the visual display mode of presets with the real-time approximate
preview.
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Presets Gallery

You will see a list of presets sorted alphabetically (AKVIS presets) or by creation date (user presets). When an image is loaded into
the program, preset thumbnails are generated.

Click on a thumbnail to select the preset. Double-click on the thumbnail starts processing the entire image.

Double-click on the name of the user preset to rename it. The AKVIS built-in presets cannot be renamed.

Use these buttons to change the display of presets:

 - to show AKVIS Presets;

 - to show User Presets;

 - to show presets marked as Favorites.

Presets thumbnails can be arranged in two ways:

 - as a vertical list;

 - filling in the entire program area.

The preset control buttons are duplicated by the context menu commands:

 Add to Favorites /  Remove from Favorites;

 Rename Preset (only for user presets);

 Move Up (only for user presets);

 Move Down (only for user presets);

 Delete Preset (only for user presets);

 Show Parameters.
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You can save your presets to a .oilpaint file with . To load presets from the file use .

Read more how to import and export user presets.
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PROGRAM PREFERENCES

The button  opens the Preferences dialog box that looks like this:

Language. Change the program language by selecting another from the drop-down list.
Interface Scale. Choose the size of the interface elements. When it is set to Auto, the program workspace will
automatically scale to fit the screen resolution.
Interface Theme. Select the style of the program interface: Light or Dark.
Initial Image Scale. This option defines the way the image is scaled in the Image Window.

- Fit to View: the image is completely visible in the window;
- 100%: the image doesn't scale (generally, only a part of the image is visible).

Preview Window Size. Choose the desired value for the size of the quick preview window: from 300х300 px to 1,000х1,000
px.
Processing Size Limit. Image processing is a very time-consuming operation. This parameter accelerates image processing
by temporary reducing the size of the image to be processed. When the file size (in megapixels) does not exceed the defined
value, the image is processed in the usual way. If the loaded file is larger, the program will reduce the image, process it and
enlarge it again to the initial size.
Recent Files (available only in the standalone version). The number of recent documents. The list of the recent files, sorted

by time, become visible by right mouse clicking . Maximum: 30 files.

Hints. You can choose how the hints will be shown:

- Under Image Window;
- Under Settings Panel;
- Hide.

Animated Processing. This option lets you observe the photo-to-painting conversion in real time. It makes the process
more entertaining but takes more time to complete. You can disable the option to improve image processing speed. In this
case, you will see the result only after processing is finished.
Timeline Shots. The option enables the Timeline feature and the parameter changes the number of the shots created during
image processing. Selecting a frame in the Timeline is only available for Home Deluxe and Business licenses.
Lock the Control Panel check-box. It disables the possibility to hide/show the top panel. If the check-box is selected the
panel is always visible.

To save changes made in the Preferences window, press OK.

To return to the default settings, click the Default button.
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BATCH PROCESSING

AKVIS OilPaint supports the Batch Processing feature that lets you automatically convert a series of images with the same
effect settings and saves you time and efforts. It is useful when creating a number of illustrations at the same style for a booklet
or when processing all frames of video.

 

If you use the standalone version of AKVIS OilPaint, read the instructions here.

If you use the OilPaint plugin in Photoshop, use this tutorial.
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PRINT IMAGES IN AKVIS OILPAINT

In the standalone version of AKVIS OilPaint you can print the image. Press the button  to open the Print options.

Print Options in AKVIS OilPaint

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the Orientation group, set the position of paper: Portrait (vertically) or Landscape (horizontally).

Click the Page Setup button to open a dialog box to choose the size of the paper and its orientation, as well as the print
margins.

Press the Reset Margins button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters Scale, Width, Height and Fit to Page. These parameters
have no effect on the image itself, just on the print version. You can change the size of the printed image by entering any
value in %, or by entering new values in Width and Height.

To adjust the size of the image to the paper size, select Fit to Page.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate Frame for the image and adjust its width and color.

Choose the Background Color by clicking on the color plate.

In the Page tab, you can adjust printing of the multiple copies of the image on a single sheet.
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Print Page

Copies per Page. It lets you specify the number of copies of the image on one page.
Horizontally and Vertically. These parameters indicate the number of rows and columns for the copies of the image
on the page.
Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a large
picture.
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Pages. If the check-box is enabled, you can specify the maximum number of the pages in which the image will be
divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the program will
automatically select the optimal number of the pages in accordance with the actual size of the image (scale = 100%).
Glue Margins. If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins will be
added to the right and to the bottom of each part.
Show Numbers. With the enabled check-box, a sequence number of each part, by a column and a row, will be printed
in the margins.
Lines of Cut. Activate the check-box to display the cut marks in the margins.

To print the image with the chosen parameters, press the Print button. 
To cancel and close the printing options click on Cancel.

Click the Properties... button to open a system dialog box that enables you to access the advanced settings and send the
document to print.
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SNOWMAN: CREATING A GREETING CARD

Winter is a wonderful time filled with snowball fights, sledding downhill and of course snowman-making. Capture the magic of the
winter season with AKVIS OilPaint by creating a holiday greeting card for your loved ones!

Oil Painting

Step 1. Open  an image in AKVIS OilPaint.

Original Image

Adjust the parameters as follows. Start processing by clicking .

Optionally, you can download the ready-to-use preset. Unzip the archive by right-clicking on it and selecting Extract.

Then load  the preset into the program.
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Step 2. Add canvas texture to the image using the Decoration -> Canvas tab. Now it looks more voluminous and lively.

Adding a Canvas

Step 3. If necessary, use the History Brush  to restore lost image details (in this case, the details of the snowman).
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Using History Brush

Step 4. You can add text and frame to the image to express your best wishes. Use the Decoration -> Text/Frame tabs.

Christmas Card

Save the image using . Now you can surprise your friends and family with a personalized greeting card!
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AKVIS PROGRAMS

 

AKVIS AirBrush — Airbrushing Techniques on Your Photos

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool that
sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using chosen
settings of photo-to-painting conversion. More…

 

AKVIS Artifact Remover AI — JPEG-Compressed Image Restoration

AKVIS Artifact Remover AI uses artificial intelligence algorithms to remove JPEG compression artifacts and restore the quality of
compressed images. This program provides 4 image enhancement modes, each involves a unique neural network developed
especially for this occasion. The software is available free of charge for home users. For commercial use, a Business license is
offered. More…

 

AKVIS ArtSuite — Frames and Effects for Your Photos

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and
texture samples that can be used to create a virtually limitless variety of options for generating frames.
Decorate a photo to give it an original and festive look! More…
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AKVIS ArtWork — Collection of Painting & Drawing Techniques

AKVIS ArtWork is photo to painting software designed to imitate different artistic techniques: Oil Painting, Watercolor, Gouache,
Comics, Pen & Ink, Linocut, Stencil, Pastel, and Pointillism. ArtWork helps you to create a piece of art out of any picture! More…

 

AKVIS Chameleon — Photo Collage Creation

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and entertaining. The tool is very
easy to handle as it does not require precise selection of objects.
Using the software you can quickly create your own photo collages. More…
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AKVIS Charcoal — Turn Photos into Charcoal & Chalk Drawings

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can make
professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding artistic effects
such as sanguine, sepia, and others. More…

 

AKVIS Coloriage AI — Add Color to Black and White Photos

AKVIS Coloriage AI allows colorizing B&W photos. The program includes an AI-powered image colorization mode based on machine
learning, as well as the classic method of manual coloring using zone selection. Breathe new life into your old family photographs!
More…

 

AKVIS Decorator — Resurface and Recolor

AKVIS Decorator lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the
volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things differently.
Recoloring is also made easy. More…
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AKVIS Draw — Hand-made Pencil Drawing Effect

AKVIS Draw converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations,
produces both B&W and color drawings. Add a hand-drawn look to your pictures! More…

 

AKVIS Enhancer — Bring Detail To Your Pictures

AKVIS Enhancer is image enhancement software that detects detail in underexposed, overexposed and mid tone areas of a photo
with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve Detail, Prepress,
and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to a picture, it lets you
improve color and adjust tones. More…

 

AKVIS Explosion — Fabulous Particle Explosion Effects

AKVIS Explosion offers creative destruction and particle explosion effects for your photos. It bursts an object and applies dust
and sand particles to an image. With the software, you can create eye-catching graphics in just a few minutes! More…
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AKVIS Frames — Decorate Your Photos with Frames

AKVIS Frames is a free program designed for working with the AKVIS frame packs

 

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The program can
also be used for photo correction. The program brings life and color to your photos! More…

 

AKVIS Inspire AI — Artistic Stylization of Images

AKVIS Inspire AI stylizes images using various samples of painting. The AI-based program applies the color scheme and style of a
selected artwork to a photo creating a new masterpiece. The software includes a gallery of art styles and allows to load a custom
sample. Imitate the style of world famous artists! More…
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AKVIS LightShop — Light and Star Effects

AKVIS LightShop lets you create an infinite number of astounding light effects! The program offers advanced lighting techniques
for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little magic to your
pictures! More…

 

AKVIS Magnifier AI — Enlarge Images & Enhance Quality

AKVIS Magnifier AI allows you to increase the size of photos and improve image quality and appearance. Featuring neural
network-based algorithms, Magnifier AI upscales images to super-high resolution, up to 800%, and produces wall-sized prints.
Improve image resolution, create clear, detailed images with perfect quality! More…

 

AKVIS MakeUp — Retouch Your Portrait Photos!

AKVIS MakeUp improves your portraits giving them a professional look. The software retouches facial imperfections making your
skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look your best in
every photo with AKVIS MakeUp! More…
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AKVIS NatureArt — Bring Nature to Your Photos

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your photos. The program includes a
number of effects: Rain

 

AKVIS Neon — Glowing Drawings from Photos

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like
drawn with luminescent ink. More…
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AKVIS Noise Buster AI — Digital Noise Reduction

AKVIS Noise Buster AI is software for noise suppression on digital and scanned images. The program is efficient for removing any
type of digital noise. It reduces both luminance and color noise without spoiling other aspects of photos. The software includes AI
technologies and adjustments for manual refining. More…

 

AKVIS OilPaint — Oil Painting Effect for Your Photos

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes. The
unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can become a
painter! More…

 

AKVIS Pastel — Turn Photos into Pastel Paintings

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one of the
most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More…

 

AKVIS Points — Apply Pointillism Effect to Your Photos

AKVIS Points lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism. With the
software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors! More…
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AKVIS Refocus AI — Focus Improvement & Blur Effects

AKVIS Refocus AI improves the sharpness of out-of-focus and blurry photos, enhances the entire image or partially, creating a
selectively focused area. It's also possible to add bokeh and lens blur effects to your photos. The program provides five image
processing modes: Refocus AI, Tilt-Shift, Iris Blur, Motion Blur, and Radial Blur. More…

 

AKVIS Retoucher — Image Restoration Software

AKVIS Retoucher is an efficient program for photo restoration and photo retouching. The software removes dust, scratches,
stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using the
information of the surrounding areas. More…

 

AKVIS Sketch — Turn Your Photos into Pencil Sketches

AKVIS Sketch converts photos into amazing pencil drawings. The software creates realistic color artworks and B&W sketches,
imitating the technique of graphite and color pencil. The program offers these photo to drawing conversion styles: Classic, Artistic,
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Maestro, and Multistyle, - each with a series of presets. AKVIS Sketch allows you to feel like a real artist! More…

 

AKVIS SmartMask AI — Selection Made Easy

AKVIS SmartMask AI is an efficient selection tool that saves time and is fun to use. Equipped with artificial intelligence tools, the
program is the most convenient and fastest way to mask objects in an image. The software considerably increases your
productivity. You will be freed from boring work and will have more room for creativity and realization of your ideas. More…

 

AKVIS Watercolor — Aquarelle Art from Photos

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The program includes two styles of
photo to painting conversion: Classic Watercolor and Contour Watercolor; each comes with a wide range of ready-to-use presets.
The software turns ordinary images into aquarelle pieces of art. More…
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